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Product description 
The SALES’UP PROJECT MANAGEMENT FOR CREATIO product – is a solution, that allows to carry out 
complex work with project tasks, create and display constituent parts of project for convenience of 
management. (Picture 1.1)

Picture 1.1

The product can be used by companies for planning and tracking project deadlines.

Use cases
• Visual project management;

• Tracking dependencies among tasks;

• Tracking the progress of the project;

• Product launch planning;

Opportunities 
• Filtering display settings (Date, Owners, Projects, etc.);

• Quick transition to tasks;

• Creation and management of tasks;

• View and control the execution time of tasks;

• Task management with ability to divide them into sprints.

Technical requirements
The product is compatible with all the products on the Creatio platform of version 7.16.1 and higher.



Sales’Up Project Management V1.1.0 23.08.2023 4

Product installation and setup
To install packages go to «System Designer» and select «Application Hub» 

On the «Application Hub» page, click on the button «New Application», then select template from 
«Marketplace powered», enter the booth address and press «Install».
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Upon installation of application package from a file, you must request an up-to-date package from Sales’Up 
support. Next, on the «Applications Hub» page click on the button «New Application», then press «Install 
from file», specify the path to the archive with the package and complete the installation. 
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General settings
Issue
To add new task, you must:

Go to the «Issue» section and click on the button «Add» (Picture 2.1)

Picture 2.1

Fill in the required and optional fields in the modal window that opens. (Picture 2.2):

• Task name (Obligatory to fill in);

• Project (Obligatory to fill in);

• Subproject;

• Work;

• Type (Select from the list (Picture 2.3));

Picture 2.2
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Picture 2.3

After saving the task, it is displayed in the registry section «Issue». For more detailed data filling, you need 
to go to the task record. The task can be opened by clicking on the corresponding button (Picture 2.4) or by 
double-clicking on the record outline.

Picture 2.4

On the task’s record page, 3 blocks are displayed (Picture 2.5)

Picture 2.5
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In the record page profile (Block 1), provide the following informatio:

• Date (Start date and end date of the task)

• Story Points (Field for specifying the number of Story Point for the current task)

• Estimate (Estimated time to complete the task, specified in the format 1w;1d;1h;1m (One week, 
one day, one hour, one minute)

• Assignee (Field for selecting a contact in the system, who will perform this task)

• Tester (Field for selecting a contact in the system, who will test this task)

• Epic (In this field, you can specify in which task the current one was created)

• Author

The fields Code, Name, Project, Work, Type will be pre-filled with the values specified when creating a 
new task.

In the record header (Block 2) there are dynamic cases (Picture 2.6) (task statuses):

• Backlog 

• To Do 

• In progress 

• To test (for testers).

• Testing 

• Done 

• Closed 

Picture 2.6

Block 3 contains tabs (Picture 2.7) with detailed information about the task.
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Рис № 2.7

On the Description tab (Picture 2.8), in the text block, you must specify a description of the task, which 
should be performed. In the input field you can attach pictures, screenshots, links, as well as changing the 
font, its size, etc.

Picture 2.8
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On the «General info» tab (Picture 2.9) the main information about the task is entered and stored, namely:

 

Picture 2.9

• Name (the name of the task can be changed if necessary)

• Date of creation (Not available for editing, date and time are filled in automatically when creating a 
task)

• Source

• Epi

• Release

In the System fields group of fields (Picture 2.10) are the fields that are unavailable for editing and are 
filled in automatically when creating/changing a task. 

Picture 2.10

In the Totals group of fields (Picture 2.11), the elapsed time and comment are indicated, other fields are 
filled in automatically.

Picture 2.11

The Link detail (Picture 2.12) indicates the connection of the current task with other tasks.
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Picture 2.12

On the File tab (Picture 2.13), if necessary, files of any format are attached.

Picture 2.13

You can attach a file in two ways:

• Drag a file on the «Drag file here» field (Picture 2.14)

Picture 2.14

• Click on the icon and in dialogue window, choose the file.

Projects
To create a project:

Go to the «Projects» section and click the «New» button (Picture 3.1).

Picture 3.1

On the new section record page that opens, fill in the following fields: (Picture 3.2). 
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Picture 3.2

In the page header (Picture 3.3) fill in the project data:

• Name (Required)

• Status (Required)

• Owner (Required)

• Code (It is needed to display task number in the «Issue» section)

This fields are mandatory to fill in. 

Picture 3.3

On the «General information» tab (Picture 3.4), provide general information about the project:
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Picture 3.4

• Account

• Contact

• Completion %

• Calculate automatically (Boolean field, enabling automatic calculation of % of project completion)

• Start

• End

• Deadline

• Duration (calculated automatically based on working hours)

In the «Connected to» fields group (Picture 3.5) indicate the connection of the document with the sale and 
the supplier.

Picture 3.5

On the «List of resources» detail (Picture 3.6) indicate the employees, who are involved in the work on 
the project.

Picture 3.6

To add an employee to the «List of resources», click on , after which the window for 
adding a new resource will open (Picture 3.7).
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In the opened window, specify:

• Project (filled in automatically);

• Name

• Contacts

• Wage

• External fee

Picture 3.7

On the «Structure» tab (Picture 3.8), specify data about project structure.

Picture 3.8

The second and third levels correspond to the «Subproject» and «Work» fields in the task (Picture 3.9) 
accordingly.

Picture 3.9
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The «Financial indicators» tab (Picture 3.10), when filling in the «Cash flows» detail, it allows you to 
calculate the financial indicators of the project.

Picture 3.10

To add new record to the «Cash flows» detail, press on the «+», after which the window for adding a new 
record will open (Picture 3.11) 

Picture 3.11

On the registration page that opens, fill in the following fields: :

• Number (Filled in automatically)

• Project (Filled in automatically)

• Purpose

• Date (Filled in automatically)

• Status

• Type

• Amount

• Category

The «Issue» tab (Picture 3.12), on the «Issues» deatil, the tasks connected to the project are displayed. 
When specifying a release in the task, a chart will be displayed on the “Issue releases” detail showing the 
percentage of tasks completed for the release and tasks that are in progress.
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Picture 3.12

The «Attachments and notes» tab (Picture 3.13), if necessary, you can add files of any format.

In the «Notes» field, You can specify a comment on the project, if necessary.

Picture 3.13

You can attach a file in two ways:

• Drag a file on the «Drag file here» field» (Picture 3.14)

Picture 3.14

• Click on the icon and, in the dialogue window, choose the file.
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Gantt Chart
One of the components of the Issue solutions is the Gantt Chart (Picture 4.1) which is a project 

management tool. 
The chart is used for:

• Creatin a complex project and managing it

• Tracking organizational work and dependencies between tasks

• Tracking project deadlines

Picture 4.1

For displaying Gantt chart, you must go to the chart view in the Issue section located in the upper left 
corner. (Picture 4.2)

Picture 4.2

Setting up Gantt chart is performed for any section of the system in which there are columns for the start 
date and end date.

To setup Gantt chart:

1. Go to System designer;

2. In the block system settings go to the «Data views» section;



Sales’Up Project Management V1.1.0 23.08.2023 18

3. In the registry field press the button «Add».

On the setting page, you need to fill in the fields (Picture 5.1.1): 

Start date column – for example, the start date of the Contract;
End date column - for example, Contract termination date;
Title column – the name of the element, for example, the number of the Contract;
Subtitle column – additional information, such as title;

Picture 5.1.1

Color column – if the object has a color column, this can be displayed on the board (Picture 5.1.2). 
In the «Grouping columns» setting, you can configure the hierarchy for displaying records on the 

chart. To add a hierarchy level, click  .

Functions have been created to change/delete levels .
In the «Filters» setting, filters are set by which the record gets into the charts.

To complete the setting, press .

The user can change the hierarchy on the Gantt chart personally for himself, to do this, go to the Gantt 
chart, open the "View" menu (Picture 5.1.3) and select "Grouping columns". (Picture 5.1.4) In this way, the 
user can change the hierarchy, which will take precedence over the general setting for a particular user.
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Picture 5.1.3

Picture 5.1.4

Using the Gantt chart view, the user can change the start and end dates for a record by dragging the 
record block on the chart or changing the start date and end date by double-clicking the corresponding 
column in the chart registry (Picture 5.1.5). 

This feature is only available for Date format columns, as in the example in the Contracts section below. If 
the format of the Date/Time column is the same as the date of registration in Cases, the change works only 
by dragging the case.
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Picture 5.1.5

For the convenience of finding the display of the block on the Gantt chart, with a single click on the required 
record in the chart registry, the block with the task will be pulled to the chart with the focus on the start date.

If in the section for which the Gantt chart is configured, there is a link detail, then such a link can be 
displayed on the chart. 

There are 4 linking types (Picture 5.1.6):

• Start - Start;

• Start - End;

• End - End;

• End - Start.

Picture 5.1.6

Using the «Zoom to fit» button (Picture 5.1.7) diagram will display all the blocks adapted to the size of the 
time scale set for the diagram.
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Picture 5.1.7

The «Collapse all» (Picture. 5.1.8) and «Expand all» (Picture 5.1.9) buttons allow you to hide or expand, 
respectively, the hierarchy configured for the chart registry, displaying the timeline along the top level of the 
hierarchy on the chart. Each click collapses/expands on top level. If there are 3 levels, you need to click 3 
times to collapse/expand everything.

Picture 5.1.8

Picture 5.1.9

Using the «Zoom in» and «Zoom out» buttons (Picture 5.1.10) the scale of the chart period is changed.
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Picture 5.1.10

To present a Gantt chart, there is a function to export data to excel (Picture 5.1.11 и Picture 5.1.12) and PDF 
files. When exporting to excel, the configurated hierarchy and chart registry columns are uploaded to the file. 

Picture 5.1.11
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Picture 5.1.12

When exporting to a PDF file, the hierarchy and columns of the chart registry are unloaded, as well as the 
timeline with the blocks displayed on it.

To export a PDF file, you must click "PDF export" and specify the page orientation and size (Picture 5.1.13 
и Picture 5.1.14)

Picture 5.1.13
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Picture 5.1.14

Kanban board
The Kanban board add-on (Picture № 5.1) is the project management tool that helps to visualize tasks, limit 
the amount of unfinished work and maximize efficiency (or speed).

Picture 5.1

To display the Kanban board, in the Issue section, click on the board icon located in the upper left corner 
(Picture 5.2)
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Picture 5.2

Kanban board settings are made for any section of the system that has a status bar or column with a status 
value.

You need to fiil in the fields (Picture 5.2.1): 
Status column – for example, the status of the Order;
Title column – the name of the element, such as the Order number;
Subtitle column – additional information, for example, Subject; 

Picture 5.2.1

Color column – if the object has a color column, it can be displayed on the diagram (Picture 5.2.2).

Picture 5.2.2
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In the «Grouping columns» setting, you can set up the hierarchy for displaying records on the table. 

To add a hierarchy level, click .

In the «Filters» setting, filters are set by which the record gets on the board.

To complete the setting, press .

The user can change the hierarchy on the Kanban board personally for himself, to do this, go to the 
Kanban board, open the "View" menu (Picture 5.2.3) and select «Grouping columns». (Picture 5.2.4) In this 
way, the user can change the hierarchy, which will take precedence over the general setting for a particular 
use.

Picture 5.2.3

Picture 5.2.4
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The user can add all the necessary information to the Kanban board block directly from the Kanban board 
view. To do this, go to the "View" menu and in the column settings for tiled display, add those columns that 
should be displayed on the Kanban board block (Picture 5.2.5).

Picture 5.2.5

Using the Kanban board, the user can move blocks from one status to another, in accordance with the 
settings of the section cases, and after moving the block from one status to another (Picture 5.2.6), the 
status will change automatically on the section records.

Picture 5.2.6

For the convenience of working with the diagram, the user can hide the levels and columns on the Kanban 
board (Picture 5.2.7).
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Picture 5.2.7

Sprints setup
Activities, projects and tasks can be combined into a sprint. To do this, you need to create a sprint 

record in the Sprints section. To create a sprint record, click NEW (Picture 5.3.1):

Picture 5.3.1

On the new record page it is enough to fill in the fields (Picture 5.3.2):
Name – the name of the sprint;
Start date – the start date of the sprint;
End date – the end date of the sprint;
Team – role or user;
Owner – responsible for sprint.
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Picture 5.3.2

For convenience, it is recommended to enable the system setting:
Add to sprint label enabled (SuAddToSprintLabelEnabled) (Picture 5.3.2) – when creating an activity or a 
task, the system setting displays a suggestion to assign a record to a sprint (Picture 5.3.3):

Picture 5.3.2

Picture 5.3.3

After clicking YES, the record will automatically be added to the Issues or Activity detail. 
A task or activity project will be automatically added to the Project detail (Picture 5.3.4). You cannot add a 
project to the Sprint manually, only when adding an activity or task.
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Picture 5.3.4

Add to sprint propose enabled (SuAddToSprintProposeEnabled)– system setting, if a task/activity was 
not linked to a sprint when created, displays an inscription suggesting linking a record to a sprint (Picture 
5.3.5):

Picture 5.3.5

If you click on the record "The current record was not added to the sprint. Add?" you will be prompted to 
attach a record to the current sprint (Picture 5.3.6).

Picture 5.3.6
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salesup-it.com
care@salesup-it.com

+38 050 140 11 22
Kyiv, Lobanovskoho Avenue, 119B


